Setup: | decided to try installing this on the oldest copy of Windows 10 that | had. Windows 10 v 1709 x64.
| installed this on a Hyper-V VM and did not give it an internet connection until the end, so this is all done offline.

If you have any version of 3d Scan installed, start by removing it. Click Start > 3d Scan, right-click and select Uninstall.
Restart your PC afterwards.

Before you continue, disconnect from the internet. This is to keep the store from messing things up when we are in the middle of installing.

Copy the desired version folder to C:\Temp. In this document | am installing 1.0.25.0 x64, but the steps are nearly identical for the other versions.
Open the appropriate notepad file, then copy/paste the command into powershell.

1. Runthe powershell command to install the packages and their constituents.

(I'am installing v1.0.25.0 x64. Just open the appropriate text file, then copy/paste the command into your powershell.)
PS C:\Windows\system32> Add-AppxPackage

stem32:>

2. Run the program. It will open up and then close. This is expected.
Note: uh... huh? When | installed this on my fresh install of Win 10 v1709 | had this issue. When | installed it on my actual workstation (Win 10 21H2) | did not have the errors. It actually opened right up.
It might have been because | had installed the v2 from the store earlier. Not sure, but noteworthy.
So if you don’t see it throwing errors in the event log, or it doesn’t close right away, you can probably skip down to step 8.

3. Open the event viewer and go to Windows Logs > System
You should see two errors. Event ID 10001 and 10016. Click on the 10016 event.
In the general text, we are looking for two pieces of data. The AppID and CLSID. Take note of these.

System  Number of events: 3

Level Date and Tirme Source Event Il Task Category
'ﬁ' Error 3/22/2022 9:03:01 AM Distrib... 10001 Mene
3/22/2022 9:03:01 AM Distrikr... 10016
(i) Information  3/22/2022 9:02:51 AM Eventlog 104 Log clear
Event 10016, Distributed COM x

General  Details

The application-specific permission settings do not grant Local Activation permission for the COM
Server application with CLSID

{94494809-13FC-4FAC-BR0A-FEABEEOFET1C)

and APPID

{30E1C3FD-EC35-490E-9CCF-CHBFIAED1919}

to the user NT AUTHORITYWLOCAL SERVICE 51D (5-1-5-19) from address LocalHost (Using LRPC)
running in the application container Unavailable 510 (Unavailable). This security permission can be
maodified using the Component Services administrative tool.

Log Mame: Systemn

Source: Distributed COM Logged: 3/22/2022 9:03:01 AM
Event | 10016 Task Categorny: Mone

Level Error Keywords: Classic

User: LOCAL SERVICE Computer: DESKTOR-067ASCU
OpCode: Info

More Information:  Event Log Cnline Help

In my test, The CLSID is {9A4948D9-13FC-4FAC-B60A-FBAGEEOFB11C}
The ApplID is {50E1C3FD-EC35-490E-9CCF-C68F9AE91919}

4. Next, we need to fix registry permissions for the CLSID.
Open Registry Editor and go to:
HKEY_CLASSES_ROOT > CLSID
Click Edit > Find, then paste the CLSID in the search box.
(or you can scroll through the list and find the CLSID manually.)
Once found, you should see an entry for the AppID. Double-check to make sure this matches the ApplID we found in the event viewer.
Right-click on the CLSID and select Permissions.

B Registry Editor — O
File Edit View Favorites Help
Computer\HKEY_CLASSES_ROOT\CLSIDY{9A4942D9-13FC-4FAC-BA0A-FBAGEEDFB11C)

{9A3E1311-23F8-42DC-815F-DDBCTE3D50BE! » || Name Type Data
{9443A344-0831-11D1-817F-0DDD0FE75570B} 5] (Defaut) REG 57 SLSClient

L e A LT Expand REG 57 {50E1C3FD-EC35-490E-9C CF-CAEFIAET1919)
{944A4451-FBIA-4F4B-9B57-A291242897 pa

{94481918-0A2F-4422-29DD-3583F455999 Mew »

{944B942C-C160-44D2-BDAA-1BDTT2440 Find...
{9A5EA90-3034-4D6F-9128-01F3C610228
{94653086-174F-1102-B5F9-00104B703EFL Delete
{9ATCIFCE-BCIE-40A3-8CD9-0F37154838, Rename
{94944225-EDAF-3421-A2FF-6A9D501 ABF
{9297f12a-6b73-4dcd-b3c1-e9244c03adac
{9AAD427B-E5C5-4A6B- ACEC-CIBE2EDSR: Permissions...
{9AARFI2D-362A-4209-9328-24A483E2CC
{92a46009-3ce0-458a-2354- 71561020756}

Click Advanced. At the top, Owner will be TrustedInstaller. Click Change.

Export

Copy Key Name




;""3“3“‘”;:2‘2‘0“3‘”"’00" 3735708 o) (Defaul) Advanced Security Settings for {FA454809- 1 36C-4EAC - BEOA-FBAEEECFBT1C) g X
T Ll )
Owner Trustedinstaller  Change
Secumy
[ Ee—— Permissions Audding Effective Acc
[ T ALL APPLICATION PACKAGES al _ _ 7
=" A = try f avi )
7 (5.1-15-3-1024-1 0653653361 28150471 For additional information, double-click a permission entry. To moddy a permession entry, select the entry and click Edie (if available)
AR 5YSTEM Permussion entries:
IR Adminatranons (DESKTOP-067ASG U Admertatrnons) x
B2 Users (DESKTOP DETASGLN Usars) v ‘ Type  Principal Access Inhented from Applies to
| € > SR Allow  Trustedinstalles Full Control None This key and subkeys
Add A ‘ B Allow SYSTEM Read None This key and subkeys
Parmssons for Account - 15& Allow  Admnistrators {DESKTOP-057... Read None This key and subkeys
UnknownS-1-15-3-1024-106536¢ How Derry | B8 Aliow  Users (DESKTOP-0STASQU\Us. Read None This key and subkeys
" Comtral. =l O |G Allow  ALL APPLICATION PACKAGES  Read None This key and subkeys
Read =] O ‘ B! Allow  Account Unknowni(S:1-15-3-_  Read None This key and subkeys
Add Reroee fiea
Enatile mberitance
[[] Replace ot child object permussion entries with inhentable permussion entries from this object
oK Cencel o

Here you have a couple options — you can assign this to your account, or you can assign it to the Administrators group.
In my test, | just assigned it to my local administrators group.
Once typed in, click Check Names. If all is correct, it will underline the object name.

Select User or Group >

Select this object type:
|User. Group, or Builtin securty principal | Chject Types...

From this location:
[DESKTOP-067A80U || Locations..

Enter the object name to select (examples):
DESKTOP-DA7AR0 UM Administrators| Check Names

Advanced... Cancel

Click OK and put a checkmark in the box “Replace owner on subcontainers and objects” and click OK.
Advanced Security Settings for {9A494209-13FC-4FAC-BE0A-FEAGEEOFB11C} O s

Administrators (DESKTOP-067ABCUNAdministrators)  Change

Replace owner on subcontainers and objects

Permipfions Auditing Effective Access

For additional information, double-click a permission entry. To medify a permission entry, select the entry and click Edit (if available).

Permission entries:

Type Principal Access Inherited from Appliesto
HR Allow  Trustedinstaller Full Contral Mone This key and subkeys
HE Allow  SYSTEM Read MNone This key and subkeys
R Allow  Administrators (DESKTOP-067... Read MNone This key and subkeys
2 Allow  Users (DESKTOP-D67A3QU\Us... Read MNone This key and subkeys
Allow  ALL APPLICATION PACKAGES  Read Mone This key and subkeys
Allow  Account Unknown(5-1-13-3-..  Read MNone This key and subkeys

Add Remaove View

Enable inheritance

[ Replace all child object permission entries with inheritable permission entries from this object

Cancel Apply

Back to the security page, find Administrators (or your account, if you took direct ownership) and put a checkmark in Full Control and click OK. Also, put a checkmark for full control under the Users group.
Permissions for {044948D9-13FC-4FAC-BE0A-FBAGEED... X

Security

Group or user names:

[E ALL APPLICATION PACKAGES ~
Account UnknowniS-1-15-3-1024-1065365536-128160471
HE SYSTEM

B2 Administrators (DESKTOP-067A8Q LN Administrators) G

S Users (DESKTOP-067A2QUNsers) < A
< >

Do this for both Administrators and Users

Permissions for Administrators
Full Contral

Read

Special permissions

For special permissions or advanced settings, Ad el
click Advanced. ———

Cca | | tody |

5. Next, we need to fix registry permission for the AppID.
Go to HKEY_CLASSES_ROOT > AppID
Edit > Find and search for the ApplID we found earlier. (Alternatively, find it in the list manually.)
Like before, right-click on the key and go to Permissions.

B Registry Editor

File Edit View Favorites Help
Computer\HKEY_CLASSES_ROOT\AppID\{50E1C3FD-EC35-490E-SCCF-CB8FSAET1S

{50d69d24-961d-4828-9d1¢c-5f4717F226d 1} A ‘ ‘ o T
{50E1C3FD-EC35-490E-9CCF-CH8FIAEG 1910 :

{513D916F-2ABE-4F51-AEAB-OCBCT6FB1AF  Expand g:
{514BSE31-5506-422F-BESS-DB0A46468385]  New 5
{515980c3- 57fe-4cTe-a561-730dd256ab98} e .
{51a1467F-06a2-4b1c-9632-4b4d950fe216}
{52551A19-B337-408d-AE75-2283E20002DE  Delete R
{52FC5917-FAE4-4CT8-BA69-20E722379F6C  Rename RE
{53362C32-A296-4F2D-A2F8-FDI84DO08340]
{53362C64-A206-4F2D-A2FS-FDOR4D083d0l  Export

{534A1E02-D58F-44f0-B58B-36CBED287CT( Permissions...
{5364EDOE-493F-4B16-9DBF-AE486CF2266(
{536AACFB-5238-4314-B4D4-5B0A2ESBS68

Copy Key Name

Click Advanced, and Owner at the top click Change
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{50d69d24-961d-4828-9d1c-5f4717F226d1} Al Mame Advanced Security Settings for {30E1C3FD-EC35-490E-9CCF-CABFOAES1919} O x
! Permissions for {30E1C3FD-EC35-490E-9CCF-CEBFIAED... X
Sty Owner: Trustedinstaller Change
Group or user names:
[E ALL APPLICATION PACKAGES A Permissions Auditing Effective Access
5-1-15-3-1024-1065365936-1281604716-3511738428-165

For additional information, double-click a permission entry. To modify a permission entry, select the entry and click Edit (if available).

SR SYSTEM

52 Administrators (DESKTOP-D67A8G U \Administrators)

Permission entries:

— —

[] Replace all child object permission entries with inheritable permission entries from this object

SR Users (DESKTOP-067A30 UM Users) 7
€ > Type Principal Access Inherited from Applies to
Add Remove HR Allow  Trustedinstaller Full Control MNone This key and subkeys
Pemissions for ALL BB Allow  SYSTEM Read Mone This key and subkeys
APPLICATION PACKAGES Allow Deny SR Allow  Administrators (DESKTOP-067...  Read MNone This key and subkeys
Full Cantrol O O HR Allow  Users (DESKTOP-067A8QUNUs...  Read Mone This key and subkeys
Read Il Allow  ALL APPLICATION PACKAGES Read Mone This key and subkeys
Special pemissions Allow  5-1-15-3-1024-1065365936-12... Read Mone This key and subkeys
For special pemiss Advanced
click Advanced. Add Remove View
Enable inheritance
oK Cancel Apply

Here you have a couple options — yo

In my test, | just assigned it to my local administrators group.
Once typed in, click Check Names. If all is correct, it will underline the object name.

Select User or Group X
Select this object type:

|User. Group, or Builtin security principal | Object Types...
From this location:

[DESKTOP-067A8QU || Locatons...
Enter the object name to select (sxamples):

DESKTOP-067ABG UAdministrators Check Mames

Advanced... Cancel

Click OK and put a checkmark in the box “Replace owner on subcontainers and objects and click OK.

u can assign this to your account, or you can assign it to the Administrators group. (Use the same account as earlier.)

Advanced Security Settings for {S0E1C3FD-EC35-490E-9CCF-CREFIAET1919]

Adrinistrators (DESKTOP-067AS0UNAdministrators) Change

Replace owner on subcontainers and objects

Effective Access

Permissions

Auditing

For additional information, double-click a permission entry. To modify a permission entry, select the entry and click Edit {if available).

Permission entries:

Type Principal Access Inherited from Applies to
SE Allow  Trustedinstaller Full Control Mone This key and subkeys
SR Allow  SYSTEM Read Mone This key and subkeys
SE Allow  Administrators (DESKTOP-067... FRead MNone This key and subkeys
SR Allow  Users (DESKTOP-06TAS0UNUs... Read Mone This key and subkeys
Allow  ALL APPLICATION PACKAGES  Read MNone This key and subkeys
Allow  5-1-15-3-1024-1065365936-12... Read MNone This key and subkeys

Add Remove View

Enable inheritance

[]Replace all child ohject permission entries with inheritable permission entries from this object

Cancel Apply

Back to the security page, find Administrators (or your account if you took direct ownership) and put a checkmark in Full Control and click OK. Do the same for the Users group, then click OK.

S1l LMArTLIES

Permissions for {S0E1C3FD-EC35-400E-9CCF-CE2FOAED...

>

Securty

GI’OIJP ar User names:

5-1-15-3-1024-1065365936-1281604716-3511738428-165 »~
SR SYSTEM

SR Admiristrators (DESKTOP-067A80 U Administrators)

82 Users (DESKTOP-D67ABGUN Users) <+

Do this for both Administrators and Users

BB Trustedinstaller A
£ >
Add.. Remaove
Permigsions for Users De
Full Contraol
Fead []
Special permissions
For special pemmissions or advanced settings, I —
click Advanced.
Cancel Apply

Ok, we're done with the registry, so close that up.
6. Next, we need to fix the DCOM permissions
Click start and type Component. Open Component Services.

Expand Component Services > Computers > My Computer > DCOM Config

You might not have this happen, but when | first opened this, | got this error.



DCOM Configuration Warning!

The CLSID {cB2192ee-6cb5-4bc0-0efd-fb318773790a), item
ChWindows'\System32vyrundll32, exe and title JumpViewExecuteHelper
has the named value ApplD, but is not recorded under

“WWHEEY _CLASSES _ROOTAppld. Do you wish to record it?

Yes Mo

This means: ‘I noticed something was missing, do you want to fix it?’
| just clicked Yes.

Next, | clicked View > Detail so | could see the Application ID.

B Component Services
. File Action View Window Help

4= $| # Large Icon

(1 Conscle Root small lcon
v (% Componer List
v [ Compu 4 Detail
v il My
L y & Customize...

Next, go through the list until you find the matching ApplD.
In my case, it is called wuapihost.
Right-click and select Properties.

Console Root\Component Services\Cormputers\My ComputeADCOM Config
(L1 Console Root A || Name | Application ID l A

v ®. Component Services & workfolderssve  {712cedb9-16a4-4f79-801d-7de24d8c706e}
v [ Computers & WorkspaceBroke... {BOSFF84E-0A77-4DD2-A919-0EABDS979DC1}
v & My Computer & WorkspacePolic... {3C3F40BC-60EB-4567-B90C-480C87C21ACT}

> || COM+ Applic; & WPDShextAutop... {A55803CC-4D53-404c-8557-FD63DBAY5D24}
v | DCOM Config & WPN Srumon Se... {ada41b3c-c6fd-4a08-8ccl1-dbefdeb7be7d}

> £ %SystemR ﬂ"wpnservice {34E76A18-223B-4E23-BEAD-F59358CC0AS0}
s & usystemR || 2 wscui. cpl {E9495B87-D950-4ab5-87A5-FF6D70BF3E0}
> B %systemrc — - —
> B Ysystemrc jwuapihost s
- X 1.'. nro men 5 = 18 Vlew )
> & %systemrc
‘ﬁ“ XAML Browser A... {ADBE6DEC-9B04-4A3D-A09C-4BB38EF1351C}

> B %systemrc
> &% 32-bit Prev
Next, go to the Security tab.

Under the Launch and Activation Permissions, click Edit, then click Add.

& Xbox Live Game ... {C5D3COE1-DC41-4F83-8BA8-CCOD46BCCDE3} Ricp i

LRV V.V NN PR . PR S R L S I S V.V S VRN 7. I Y. C R 1

wuapihost Properties ? e [ =] &l.
Launch and Activation Permission ? X

1 General Location Security Endpoints Identity

i Securty
Launch and Acti n Pemissions

N Group or user names:
O Use Default -5 Account Unknown(S-1-15-3-1024-2707581722-397039807...
(® Customize [ . | 88 S¥STEM

a? Account Unknown(S-1-5-32-2707581722-3570358075-330...
52 Administrators (DESKTOP-067A8QUNAdministrators)

S8 INTERACTIVE
Access Pemissions
(O Use Default = ‘ ‘ = ’
(® Customize a7 Pemissions for Account
n‘ Edit... ) Unknown(S-1-15-3-1024-270758" Allow Deny

Local Launch ™ O

Remote Launch | |
Configuration Pemissions el Rt O
(O Use Default Remote Activation O O
(® Customize Rt |

ok || Cancel |
Leam more about setting these properties. e

In the object search box, type in LOCAL SERVICE and click Check Names. It should underline itself.
Note: If Local Service does not resolve, try NT AUTHORITY\LOCAL SERVICE instead. One of these two should work.

Select Users or Groups et

Select this obhject type:
|Users. Groups, or Builtin security principals | | Object Types... |

From this location:
|DESKTOP-067A8QU || Locations... |

Enter the object names to select (examples):

LOCAL SERVICE] Check Mames

Advanced. . [ ok | cance |

Click OK.
Now put a checkmark in the box for Local Activation.



Launch and Activation Permissicn ? >

Security

GFCIIJP ar User Nnames:

l? Accourt Unknown(5-1-5-32-2707581722-3970398075-330 »~
SR Administrators {DESKTOP-067A83 U Administrators)

SR INTERACTIVE

828 LOCAL SERVICE

L4 >

| Add... || Remove |

Permissions for LOCAL SERVICE Allow Derny

Local Launch
Femcte Launch
Local Activation
Remate Activation

[ ok | cancel

Click OK, then click OK again. Close the Component Services window.
7. Restart the computer.

8. Next, we need to change some NTFS permissions to prevent the store from updating the 3d Scan app.
Open file explorer and click View, and put a checkmark in Hidden items

M| A | = ThisPC

Computer View

l___] i | [ Medium icons

2 Small icons

[ ]' I:] Item check boxes 3 E

EE List f== Details [] File name extensions
Navigation 0= = Hide selected  Options
Hanss 08 [EE Tites EE Content [V Hidden items o s

Panes Layout Current Show/hide

& Downloads #* ;i -

| Documents *
Documents Downloads

[&] Pictures * iﬁ ‘

ANSrcanw1N250

Next, browse to C:\Program Files.
Once here you should see a greyed out WindowsApps folder.
Right-click on it and select Properties.

| < | Program Files Open in new window
[ File Home Share View Pin to Quick access
<« v A » ThisPC > Local Disk (C:) » 7 >
o CRC SHA >
Name .
Scan with Windows Defender...
3 Quick access _ EE
[ Desktop * e ) Give access to 3
Comeion File- Restore previous versions
v‘ Downloads b 4 E—
I Ll Sridet Include in library >
E} Documents o Uninstall Informatio Pinto Start
[&=] Pictures * Windows Defender
3DScan v1.0.25.0 Windows Defender 4 Send to >
Jy Music Windows Mail Cut
B Videos Windows Media Pla; Copy
Windows Multimed
&@& OneDrive e 9 Create shortcut
. . Delete
E;: This PC Windows Photo Viey 9 2
Windows Portable D
¥ Network Windows Security Properties
WindowsApps A Ay R (-

Go to the Security tab and click Advanced.
In my case, it said it was unable to display the current owner. Click Change
Type in Administrators and click Check Names.

Click OK
Advanced Security Settings for WindowsApps m} X
Mame: CAProgram Files\WindowsApps
Owner: Unable te display current owner. 8 Change
Permissions Auditing Effective Access
o‘f’ou must have Read permissions topeeuth i ok bhic abioct

Select User or Group et
Click Continue to attempt the oper

Select this object type:

|U5er. Group, or Builtin securty principal | | Chbject Types... |

From this location:

[DESKTOP-067A8QU || Locations... |

Enterthe object name to select (examples):
DESKTOP-D67A80 UM Administrators Check Names

T =

| OK || Cancel | Apply

Place a checkmark in Replace owner on subcontainers and objects, then click OK.



Advanced Security Settings for WindowsApps O >

MNarne: Ch\Program Files\WindowsApps

Administrators (DESKTOP-06TASQUNAdministrators)  Change

Replace owner on subcontainers and objects

Permissions Auditing Effective Access

For additicnal information, double-click a permission entry. To modify a permission entry, select the entry and click Edit (if available).

Permission entries:

Type Principal Accesz Condition Inherited from  Applies to G
8B Allow  Trustedinstaller Full control MNone This folder...
Allow  5-1-13-3-1024-363528... Read & ex.. MNone This folder...
BB Allow  SYSTEM Full control Mone This folder...
SR Allow  Administrators (DESKT... List folder ... MNone This folder...
8B Allow  LOCAL SERVICE Read & ex... MNone This folder...
BB Allow  NETWORK SERVICE Read & ex.. Mone This folder...
SR Allew  RESTRICTED Read & ex... MNone This folder...

i Allowy = - = Ee fd & { c . ] [# =

Add Remove View

Enable inheritance

Cancel Apply

Once permissions have been set, click OK Then click OK to close the properties window.

Now double-click on the WindowsApps folder.
You will get a permission warning. Click Continue to give yourself permissions.

¥

Windows Multimedia P| WindowsApps e

windows nt
Windows Photo Viewe, /. You don't currently have permission to

Windows Portable Devi access this folder.

Windows Security Click Continue to permanently get access to this

WindowsApps folder.

WindowsPowerShell

¥ Continue Cancel

Now you should be presented with a list of the windows store apps. We are looking for:
Microsoft.3DScan_1.0.25.0_x64__8wekyb3d8bbwe
Right-click and select Properties.

Cut >_<
Co
View . o
Create shortcut
» Local Disk (C:) » Program Files * Windowslpps » el
Delete
ame Rename Size ™
Deleted Properties
Microsoft.305can_1.0.25.0 x84 Bwekyb3d8bbwe i m[

On the general tab, under attributes there should be a checkbox for Read-only that has a block instead of a checkmark.
Click this box twice to put a checkmark in, then click OK.

Microzoft.305can_1.0.25.0 x84 8wekyb3dibbwe Prop... > L

General Sharng Secunty Previous Versions  Customize

licrosoft. 305can_1.0.25.0_x64_ Bwekyb3d8bbwe

Type: File folder {.0_x64__ Bwekyb3d8bbwe)
Location: C:AProgram Files'"WindowsApps
Size: 3.23 MB (3,351,404 bytes)

Size on disk:  3.40 MB {3,567 616 bytes)

s Click twice to convert this to a checkmark.

Contains: &7 Files, 6 Folders

Created: Today, March 22, 20

Aftributes: [®] Read-only (Only applies to files in folder)
[ ] Hidden Advanced...

Cancel Apply

At the prompt, select Apply changes to this folder, subfolders and files, then click OK.

Confirm Attribute Changes ot

You have chosen to make the following attribute changes:

set read-only

Do you want to apply this change to this folder only, or do you want to
apply it to all subfolders and files as well?

Apply changes to this folder only
(®)iapply changes to this folder, subfolders and files!

Corcel

This should prevent the windows store from overwriting the app.

9. Now you can reconnect to the internet.



10. Now run 3d Scan. It should launch properly.

= 30 Scan

Congrats! You are done!

Adjust your scanning volume

Width

Choose your scan resolution

Kinect sensor Handheld

Set up a timer for your scan

Start

Stop

O




